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Abstract
[Purpose] Many stages of the book editing and publishing process are gradually
transitioning from traditional methods to digital approaches, but the degree of
digital development varies across different stages. This article primarily explores
the digitalization of editing and quality inspection stages in the book editing
and publishing process.

[Methods] Through practical application in actual work, some practical oper-
ational techniques are summarized; since applications and experience related
to digitalization of quality inspection are relatively limited, this paper explores
the models and specific processes of digital quality inspection, and proposes an
implementation plan design.

[Results] Conducting digital exploration helps improve the work quality and
efficiency of personnel involved in book editing and publishing, and further
promotes the digital development of the book publishing industry.

[Conclusion] The transformation from traditional publishing to digital publish-
ing represents a development trend in the book publishing industry; publish-
ing houses should utilize continuously evolving information technology to pro-
mote the application of digitalization in the book editing and publishing process,
thereby achieving high-quality and sustainable development.
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Abstract
[Objective] Many stages in the book editing and publishing process are grad-
ually transitioning from traditional to digital methods, though the degree of
digitalization varies across different stages. This article primarily explores the
digitalization of editing and quality inspection stages in book editing and pub-
lishing. [Methods] Through practical application in daily work, we summarize
several useful operational techniques. Since digital applications and experience
in quality inspection are relatively limited, we explore digital quality inspection
models and specific workflows, proposing an implementation plan. [Results]
Digital exploration helps improve the work quality and efficiency of personnel
involved in book editing and publishing, further promoting digital development
in the publishing industry. [Conclusion] The transition from traditional to dig-
ital publishing represents a development trend in the book publishing industry.
Publishers must leverage continuously evolving information technology to pro-
mote digital applications throughout the book editing and publishing process,
thereby achieving high-quality, sustainable development.
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With the continuous development of science, technology, and computer tech-
nology, and the increasing popularity of the Internet, information technology
applications are becoming more frequent across all industries. The publishing
industry is no exception, as traditional book publishing has been significantly
impacted and is gradually implementing digital transformation, accelerating its
digitalization process. To achieve better development, publishers must actively
engage in practice and exploration, introduce digital publishing technologies,
and cultivate digital editing and publishing professionals on the basis of chang-
ing traditional concepts. This will lead editing and publishing work toward
digitalization, drive their own digital transformation, and form unique industry
advantages [1-3].

The general process of book editing and publishing includes multiple stages, such
as topic selection, editing, design and layout, proofreading, pre-press quality
inspection, printing and binding, and marketing and distribution [4]. Among
these, some stages have achieved a certain degree of digitalization, while others
require further exploration to ensure the long-term stable development of the
book publishing industry. Due to the extensive content involved in each stage of
the book editing and publishing process, this article cannot cover everything and
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will focus only on introducing the digitalization of editing and quality inspection.

1. Digital Techniques for Editing
For the editing stage in book editing and publishing, the following techniques
are particularly practical.

1.1 Word Software

The vast majority of manuscripts received by publishers are in Word format.
From manuscript receipt to editing and author revision, editors can record and
archive relevant information on the computer for future reference when needed.
This improves editors’work efficiency and enhances manuscript review quality.

Word is a commonly used word processing software with powerful built-in func-
tions. For example, using the “Track Changes”function, all edits made by
editors leave clear, distinguishable, and traceable marks. Mastering certain
Word operation techniques can make editors’work much more efficient.

1.1.1 Switching Between Superscript and Normal Format Using the
shortcut key, first select the content that needs to be changed to superscript or
changed back to normal format, then press the“Shift+Ctrl+=”key combination
[8].

1.1.2 Uniformly Deleting Links Sometimes URLs or key terms in
manuscripts contain hyperlinks, which affect the opening and running speed of
the document. Using the shortcut key, first press“Ctrl+A”to select all content,
then press “Shift+Ctrl+F9”to delete all links in the manuscript uniformly.

1.1.3 Auto-Save Click “File”→ “Options”→ “Save”and set the time in-
terval in “Save AutoRecover information every.”For science and engineering
manuscripts containing many charts and formulas, which are prone to issues
(such as crashes or unexpected closures) during editing, it is recommended to
set a shorter interval, such as 5 minutes or even 3 minutes. This way, even if
Word malfunctions, the loss will be minimal. For manuscripts consisting mainly
of text, a longer interval can be set, such as 8 minutes or even 10 minutes.
Depending on the specific manuscript or work requirements, you can check or
uncheck the box for“Keep the last auto-saved version if I close without saving.”

1.1.4 Custom Groups During manuscript review, editors frequently need to
change fonts, font sizes, or case (under the“Home”tab), insert circled numbers
or special characters (under the“Insert”tab), insert footnotes (under the“Ref-
erences”tab), etc. Switching between these tabs is cumbersome. By creating a
new group, you can place commonly used commands in one group. Right-click
on the“Ribbon”in Word and select“Customize the Ribbon”to open the“Word
Options”dialog box. In the left panel, select the command you want to add
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from “Choose commands from,”then click the “Add”button in the middle to
add the command to your custom group on the right.

Note that due to computer screen limitations, if too many commands are added
to a custom group at once, the icons will automatically shrink, making them
difficult to use. Therefore, it is recommended to add commands commonly used
for the specific manuscript being reviewed to the custom group based on actual
needs.

1.1.5 Comparing Documents Generally, editors return manuscripts to au-
thors for revision. Sometimes, for various reasons, authors do not use the“Track
Changes”function when revising, resulting in a returned manuscript without re-
vision marks. This makes it impossible for editors to know what has been
changed. In such cases, click “Review”→ “Compare”to open the “Compare
Documents”dialog box. Select the manuscript before the author’s revision as
the “Original document”and the manuscript after revision as the “Revised
document,”then click“OK.”A comparison document will be generated, clearly
showing all author modifications as revision marks.

1.1.6 Splitting Documents Sometimes manuscripts are too large and prone
to problems, or time is tight and multiple review stages need to proceed simul-
taneously. In these cases, editors can use Word’s document splitting function.
First, set the heading levels of the manuscript (generally up to three levels is
sufficient; this can be viewed through the “Document Structure Map”), then
click“View”→“Outline View.”For clarity, you can select“Level 1”in the“Show
Level”box to display only first-level headings, hiding other content. Click“Show
Document,”select all first-level headings, click“Create”→“Close Outline View,”
close and save the manuscript. At this point, multiple files (subdocuments) will
appear in the folder where the manuscript (master document) is located, named
after each first-level heading. Different people can edit each subdocument sepa-
rately. After all work is completed, in the master document’s “Outline View,”
click“Expand Subdocuments,”select“Level 1”in the“Show Level”box, select
all first-level headings, and click “Show Document”→ “Unlink”to obtain the
complete edited manuscript.

Other commonly used functions such as unified find and replace, unified foot-
note format modification, setting heading styles and automatic table of contents
generation, adding or adjusting page numbers are simple operations and will not
be elaborated here.

1.2 Professional Proofreading Software

In practice, publishers can equip themselves with professional proofreading soft-
ware such as Heima Proofreading [9] and Founder Proofreading. Before editing,
editors can use this software to process manuscripts. This effectively avoids er-
rors caused by human oversight and reduces editors’workload, improving work
efficiency.
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Taking Founder Proofreading as an example, it has PDF and Word versions
with multiple functions, including one-click proofreading, general checks (char-
acter check, sensitive content check, contextual duplicate check, logic check),
special checks (knowledge check, reference format, batch duplicate check, for-
mat check), special processing (chart management, name sorting), and special
features (pinyin annotation, image-to-table conversion, etc.). Its advantages
include:

First, speed. For a manuscript of approximately 150,000 words, both PDF and
Word versions take about 1 minute and 40 seconds, saving time and effort.

Second, comprehensive scope. It can proofread Chinese characters, for-
eign languages and translations, punctuation marks, charts, and other content.
Founder Proofreading has multiple professional lexicons and uses different spe-
cialized lexicons for manuscripts from different fields. It can also check document
logic, such as document outlines and numbering (including figure numbers, ta-
ble numbers, formula numbers, etc.). If there are discontinuities or duplicates
in headings or numbers, the proofreading results will be highlighted in red for
easy identification.

Third, high error detection rate. Proofreading results in both Word and
PDF versions distinguish different error types with different colors, such as
sensitive errors, serious errors, general errors, and questionable errors. It accu-
rately identifies irregular simplified characters, typos, incorrect Chinese idioms,
etc. Users can customize proofreading settings, such as setting the “Sensitive
word check strictness level”to “Lenient,”“Normal,”or “Strict,”or setting the
“Duplicate check”to“$�15𝑐ℎ𝑎𝑟𝑎𝑐𝑡𝑒𝑟𝑠, ""�30𝑐ℎ𝑎𝑟𝑎𝑐𝑡𝑒𝑟𝑠, ""�50𝑐ℎ𝑎𝑟𝑎𝑐𝑡𝑒𝑟𝑠, "𝑜𝑟"�$100
characters.”

Fourth, timely updates. Some laws, regulations, national standards, and
industry standards are revised or updated periodically, and relevant institutions
and organizations release new documents and reports. The software updates
these materials promptly to support editing work.

Fifth, support for lexicon expansion. Founder Proofreading has a lexicon
management function that allows editors to add entries and manage lexicons
themselves, improving proofreading accuracy.

2. Digital Exploration of Quality Inspection
Currently, publisher quality inspection mainly includes pre-press quality inspec-
tion (before book publication) and post-publication quality inspection (after
book publication). In both cases, submitted books are generally printed pa-
per copies. In the current information age, with continuous development and
advancement of computer technology, the transition from traditional to digital
publishing represents a development trend in the book publishing industry. To
achieve complete digitalization of the entire book editing and publishing work-
flow, publishers must explore digitalization of the quality inspection stage.
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Changing the current quality inspection model to adopt an unfamiliar new dig-
ital quality inspection model requires quality inspectors to first accept it psy-
chologically, then continuously accumulate experience in practice, identify prob-
lems, solve them, and ultimately form a relatively mature and complete digital
quality inspection process.

2.1 Significance

First, building a digital quality inspection model can advance the digitalization
of books and business processes, ensure book publishing quality, and improve
the overall quality of quality inspection work.

Second, building a digital quality inspection model can achieve datafication and
intelligence at the back end of quality inspection, providing support for book
quality improvement and early-stage processes (such as topic selection).

Third, building a digital quality inspection model can break through time and
space limitations, enable real-time online file transmission, provide convenience
for remote work, help improve quality inspection efficiency, and save time and
labor costs.

Fourth, as part of the digital publishing workflow, digital quality inspection can
effectively connect with early-stage processes such as topic selection and editing,
facilitating the establishment and improvement of the entire digital publishing
system.

Fifth, establishing a database of book editing and quality inspection results helps
produce high-quality books, enriches book varieties and formats, and promotes
better development of the book publishing industry.

Sixth, building a digital quality inspection model helps solve some existing prob-
lems in current quality inspection work [10]. For example, there are increas-
ing numbers of two-color and even four-color printed books. Compared with
monochrome printing, these books have more lively layouts with highlighted
key points, making them more attractive to readers and stimulating their inter-
est in learning. However, submitted manuscripts are generally printed in black
and white, creating blind spots in checking design elements in colors other than
black. Digital quality inspection can effectively solve this problem.

How to expand digital quality inspection methods to make quality inspection
work more convenient and operational? How to better connect editors with
subsequent work to improve efficiency? These issues require further discussion
and exploration.

2.2 Implementation Plan Design

First, clarify the requirements for digital book quality inspection and gradually
establish and improve the digital quality inspection system. Specific require-
ments are as follows: (1) Submitted manuscripts must be in PDF format with
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complete components, including cover, main text, and supplementary materials;
(2) Quality inspectors must check a minimum of 100,000 words per book, use
unified software and versions (such as Adobe Acrobat, PDF-Xchange Viewer,
etc.) to ensure compatibility, use unified annotation methods with proofread-
ing symbols to ensure clear layouts for easy reference, and follow standardized
procedures (editors submit quality inspection requests, quality inspection de-
partments assign tasks, inspectors accept tasks, and after completing inspec-
tions, generate and submit the “Book Editing and Quality Inspection Results
Record Form”); (3) Feedback channels for inspection results must be unob-
structed, allowing editors to raise questions about inspection results through
these channels.

Second, establish a database of book editing and quality inspection results [11].
After completing digital quality inspection, inspectors generate the“Book Edit-
ing and Quality Inspection Results Record Form,”which is archived uniformly
or placed in a database for future query, retrieval, and analysis. This enables
relevant personnel to understand the types and proportions of various errors,
helping editors focus on specific issues during editing to reduce the probability
of similar errors in the future and improve work quality and efficiency. It also
provides guidance for early-stage processes such as topic selection. For exam-
ple, non-standard professional terminology is a common type of error. Acqui-
sition editors can instruct authors to pay special attention to this issue during
manuscript solicitation and use the“Term Online”website of the China National
Committee for Terms in Sciences and Technologies to determine which terms
are standard and which are not, reducing errors at the source and improving
manuscript quality.

Finally, rely on the technical support provided by ERP systems. Using ERP
(Enterprise Resource Planning) systems as a support platform, connect all stages
of the entire book editing and publishing workflow to the ERP system. In the
ERP system, quality inspection workflows, timelines, inspectors, and results are
clearly recorded, enabling intelligent management of digital quality inspection
work. Meanwhile, using ERP system backend data combined with relevant data
analysis software can help identify problems in the digital quality inspection
system and propose reasonable solutions.

In the early stages of exploring digital quality inspection, the book format can
primarily focus on the most commonly used PDF files. With accumulated expe-
rience and deeper work, book formats can be expanded to EPUB, DPUB, AR,
etc.

3. Challenges and Solutions
3.1 Human Factors

Although digital publishing technology has developed to a certain extent in
the book editing and publishing process, a considerable portion of editing and
publishing work has not widely applied it. The reason is that relevant personnel
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lack correct understanding of digital publishing technology, remain confined
to traditional editing and publishing workflows, are unwilling to change their
mindsets, and have weak digital awareness, resulting in slow digital development
of editing and publishing work [12].

To address this issue, we recommend:

First, relevant management personnel in publishing houses should strengthen
their awareness of digital management, which is a strong guarantee for achieving
digital development. In practice, managers can regularly participate in digital
publishing technology and digital editing technology seminars to continuously
enhance their understanding of digital technology and update their management
concepts. Additionally, managers must continuously learn advanced digital edit-
ing and typesetting technologies to effectively supervise and manage their staff
and create a good digital work and learning atmosphere together with them
[13].

Second, relevant business personnel in book editing and publishing must recog-
nize the importance of digitalization, accept it psychologically, and gradually
develop digital publishing awareness. Only then can they shift from“passive”to
“active”digitalization and achieve editing transformation in the digital age [14-
15]. Furthermore, all parties—including editors, quality inspectors, and technical
personnel—must communicate fully, actively participate in relevant training ac-
tivities, learn digital knowledge, improve their skills, enhance work efficiency,
and can refer to and learn from the digital professional techniques and concepts
of other publishing units.

3.2 Resource Factors

In the book editing and publishing process, some publishing units have insuffi-
cient investment and cannot purchase advanced equipment and software, result-
ing in incomplete digital equipment and software that fails to meet expected
quality and efficiency standards. Digital editing and publishing technology is
not used reasonably and effectively, and editing and publishing efficiency cannot
be improved. To address this issue, digitalization of the book editing and pub-
lishing workflow requires certain equipment and technical support. Publishers
must expand their investment, actively introduce advanced digital editing and
publishing equipment and software, and ensure that equipment performance,
software stability, and compatibility meet work requirements. This ensures
work quality and efficiency in practice and promotes the digitalization process
of editing and publishing work. At the same time, publishers must also equip
auxiliary devices such as printers and scanners and purchase commonly used
databases.

In the current information age, the rapid and stable development of China’s book
publishing industry cannot be separated from the extensive and in-depth appli-
cation of digital publishing technology. Publishers must leverage continuously
developing information technology to promote digital applications throughout
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the book editing and publishing process, constantly identify and solve prob-
lems, optimize and improve digital editing and publishing work, and gradually
enhance their core competitiveness. This will place them in an advantageous
position in market competition and achieve high-quality, sustainable develop-
ment.
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